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StyleEase for Chicago/Turabian  Style
SECTION 1 • 
Getting Started

This section introduces you to StyleEase, and quickly gets you started using its basic 
features. After reading this section, you’ll be able to create and edit StyleEase documents 
effectively, and you’ll know where to find help with more advanced features of our 
products.

StyleEase* is a software product packaged into a Microsoft Word template. You can 
create documents based on this template and then use all of the product’s features for 
delivering papers, theses, and dissertations in Chicago/Turabian Style (based on the 
guidelines in the Chicago Manual of Style, 15th Edition and Turabian’s A Manual for 
Writers of Term Papers, Theses, and Dissertations, 6th Edition. We refer to these two 
together as Chicago/Turabian style.). 

StyleEase simplifies many aspects of document creation and editing, including page 
layout (numbering and headers/footers), text formatting, citing references, adding and 
deleting special pages, and management of special lists like the Table of Contents and 
List of Illustrations.

We recommend that you orient yourself with StyleEase by spending an hour or so 
familiarizing yourself with the topics in this section:

• Enabling StyleEase

• Creating a New Document

• Entering Document Content 

• Citing References

• Changing Page Headers and Numbering

• Preparing and Printing Documents
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Enabling StyleEase
Whenever you open a StyleEase document, Microsoft Word detects that the document 
contains macros (the StyleEase software), and determines if it’s safe to allow that 
software to run. StyleEase signs its software with a digital certificate from Thawte; such 
certificates are issued only after Thawte verifies the identity and validity of the signer.

If you tell Word to trust our certificate, then StyleEase can run without intervention; 
otherwise, Word needs to ask you about our safety each time it opens a document.

Different versions of Word use different methods to allow you to trust our certificate:

Trusting Our Certificate in Word 2003 or Earlier 
Versions
Word displays a security warning when you first create a StyleEase document, as shown 
in Figure 1-1.

Figure 1-1: Trusting the StyleEase Certificate in Word 2003

Select the Always trust macros from this publisher box, and then click Enable Macros.
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Trusting Our Certificate in Word 2007
You must enable our macros to use StyleEase. We recommend that you set Word 2007’s 
security settings to only enable macros that have been digitally signed, and to then trust 
our certificate. You need to follow these steps:

1. Change Word 2007’s Macro Setting to Disable all macros except digitally signed macros.

2. Create a new StyleEase document from the Windows Start Menu.

3. Trust the StyleEase Digital Certificate.

You only need to perform these steps one time on your computer; thereafter, Word will 
automatically allow any StyleEase documents to run without requiring extra steps.

Change Word 2007’s Macro Setting
1. Click the Office button in the top-left corner of a Word 2007 document window.

2. Click the Word Options button at the bottom of that screen.

3. Click Trust Center and then click Trust Center Settings

4. Select the option to Disable all macros except digitally signed macros, as shown in Figure 
1-2.

Figure 1-2: Changing the macro settings in Word 2007

5. Click OK to save this change.

Trust the StyleEase Digital Certificate

When you first create a StyleEase document after you’ve changed the macro settings, 
Word will initially disable the macros and display both a message screen and a Security 
warning, which is shown in Figure 1-3.

Figure 1-3: The Word 2007 security warning
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To allow StyleEase to run, follow these steps:

1. Close the message screen.

2. Click the Options button in the security warning. Word displays the security options 
screen shown in Figure 1-4.

Figure 1-4: The Word 2007 security options screen

3. Select the Trust all document from this publisher and click OK. Thereafter all documents 
signed with our certificate will be trusted by Word 2007.

Creating a New Document
To create a new StyleEase document:

a. Click the Windows Start button, then click All Programs, and then click StyleEase.

b. Click Chicago Style Document. (If you’re using a version that has been customized 
for your institution, click the name of the custom version, e.g. SWBTS Style 
Document).
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c. Select options for your document in the StyleEase Document Setup screen, as shown 
in Figure 1-5.

Figure 1-5: The Document Setup screen

The Creating StyleEase Documents topic provides additional information about creating 
new documents, and the Basic Document Types topic describes each of the document 
types you can create with StyleEase.

Using StyleEase Commands
You access the features of StyleEase by selecting commands from the StyleEase menu (in 
Word 2003 and earlier) or from the StyleEase ribbon tab (in Word 2007). See Using the 
StyleEase Commands for more information about each command.
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The StyleEase Menu for Word 2003 and Earlier Versions

The StyleEase menu, shown in Figure 1-6, appears on the right side of Word’s menu bar, 
and contains a number of commands and several submenus, which are indicated by a 
small right-arrow in the menu itself. To use a StyleEase command, simply click the menu 
choice, or click the right-arrow to reveal the submenu, and then click a command in the 
submenu.

Figure 1-6: The StyleEase Menu

The StyleEase Ribbon Tab for Word 2007

The StyleEase ribbon tab, shown in Figure 1-7, also presents a number of command and 
drop-down lists, which are organized into sections (groups) for easier access. To use a 
StyleEase command, simply click the item in the ribbon tab, or click the down-arrow to 
reveal the drop-down list and then click an item in the list.

Figure 1-7: The StyleEase Ribbon Tab
StyleEase User’s Guide 6



Entering Document Content
The heart of working with StyleEase is in entering your document’s content: the text of 
your paper, the figures and tables you want to include, and any special pages (such as an 
abstract or appendix) or lists (such as a table of contents) that you need.

Entering text and applying styles

StyleEase defines styles in Word that automate the formatting of your document; each 
style is defined in accordance with the Chicago/Turabian style guidelines, and each 
specifies the spacing, margins, font, and other paragraph attributes. 

In most cases, you simply type and StyleEase applies the correct formatting. If you need 
to change the style of a paragraph — for example, to create a new heading in your 
document — you apply a style. Note that you can apply a style and thus reformat a 
paragraph whenever you want.

In Word 2003 or earlier, apply a style by selecting a style name from StyleEase’s Format 
Text submenu. In Word 2007, apply a style by selecting a style name from one of the 
drop-down lists in the Format section of the StyleEase ribbon tab.

For more information about using our styles, see the Text Formatting with StyleEase 
Styles topic.

Adding Pages and Lists

When you create a new StyleEase document, you can specify that you want to include 
certain special sections, such as an abstract page, an appendix, or a table of contents, as 
described in the Creating a New Document topic. You can also add these sections 
(special pages or lists) while working on your documents.

To add a page such as an abstract or appendix, click the Insert New Page submenu in the 
StyleEase menu or click the Special Pages drop-down in the StyleEase ribbon tab. Then 
select the type of page you want to insert. Figure 1-8 shows selecting a new page to insert 
in Word 2007.
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Figure 1-8: Inserting a New Special Page

To add a special list such as a Table of Contents or List of Figures, click the Insert Element 
submenu in the StyleEase menu or click the List drop-down in the StyleEase ribbon tab. 
Then select the type of special list you want to insert.

Figure 1-9: Inserting a New Special List

Note that you can also delete special pages and lists from your document at any time by 
using the Delete Section command in the StyleEase menu or ribbon tab.

Adding Figures and Tables

If you need to insert a figure (a graphic image) or a table into your document, StyleEase 
provides commands to simplify and automate the process.

To insert a figure, click the StyleEase Insert Element submenu and then select the Figure 
with caption command; in Word 2007, click the Figure item in the StyleEase ribbon tab. 
You are guided through browsing to the image on your computer, and then specifying a 
caption for the figure. If your document includes a List of Illustrations (or List of Figures) 
page, that list is automatically updated for the new figure. For more information about 
inserting figures, see the Inserting Figures topic.

To insert a table, click the StyleEase Insert Element submenu and then select the Table with 
caption command; in Word 2007, click the Table item in the StyleEase ribbon tab. You are 
guided through specifying the layout of the table, and then specifying its caption. If your 
document includes a List of Tables page, that list is automatically updated for the new 
table. For more information about inserting figures, see Inserting Tables.
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Citing References
One of the most difficult tasks you face in working with academic documents is citing 
references. StyleEase simplifies and automates this by providing a menu of reference 
types. After you select the type of reference you want to insert, StyleEase asks you for the 
information required to properly cite the reference. StyleEase then:

• correctly formats the reference

• inserts it into your Works Cited list

• adds a citation, footnote, or endnote to your document

Creating References Manually

To create a new reference entry, select Create Reference Entry from the StyleEase menu, or 
click Create in the References section of the StyleEase ribbon tab. Then select a reference 
type from the References menu that StyleEase displays, which is shown in Figure 1-10.

Figure 1-10: Selecting a reference type

After you make a selection, StyleEase displays an information screen for your reference 
type. An example is shown in Figure 1-11. Enter information for the reference and click 
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the Insert Reference button to add the reference to your document. Note that StyleEase 
color codes required (red) and optional (blue) fields in each reference information 
screen.

Figure 1-11: A reference entry information screen

For more information about creating references, see Citing References.

Changing Page Headers and Numbering
The page layout of your document — its working title, how the pages are numbered, 
and the running header that appears on each page — is set up for you by StyleEase when 
you create a new document. You can customize the appearance of your document by 
modifying these layout characteristics at any time.

To change the layout of your pages, click Update Page Layout in the StyleEase menu, or 
click either Numbering or Headers in the Page Layout section of the StyleEase ribbon tab. 
Then select the options you want and click OK.
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Figure 1-12: Modifying page headers and numbering

The Changing Page Headers and Numbering topic provide detailed information about 
the page layout options.

Preparing and Printing Documents
When you’re ready to print your document, it’s a good idea to use the StyleEase print 
preparation feature to make sure that your references are correctly sorted (alphabetized) 
and that all of your special lists have the correct page numbering. 

Click Prepare for Printing in the StyleEase menu or click Print Prepare on the StyleEase 
ribbon tab to display the Print Preparation screen, which is shown in Figure 1-13. Select 
the updates that you want to perform before printing, and then click OK.
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Figure 1-13: Preparing for printing

For more information, see the Updating Your Document for Printing topic.
StyleEase User’s Guide 12



StyleEase for Chicago/Turabian Style
SECTION 2 • 
Using StyleEase

This section describes how to use the basic functionality of StyleEase, in the following 
topics:

• Editing Title Pages tells you how to customize the title pages that StyleEase can use 
Enabling StyleEase shows you how to allow access to StyleEase’s functionality in your 
Word documents.

• Creating StyleEase Documents provides information about the StyleEase Document 
Setup screen, with which you specify the initial appearance and contents of new 
StyleEase documents.

• Using the StyleEase Commands explains how to use the StyleEase menu or ribbon tab 
to access all of our commands.

• Formatting Existing Documents explains how to convert an existing document into a 
document that can take advantage of StyleEase’s capabilities.

Editing Title Pages tells you how to customize the title pages that StyleEase can use 

Enabling StyleEase
Whenever you open a StyleEase document, Microsoft Word detects that the document 
contains macros (the StyleEase software), and determines if it’s safe to allow that 
software to run. StyleEase signs its software with a digital certificate from Thawte; such 
certificates are issued only after Thawte verifies the identity and validity of the signer.

If you tell Word to trust our certificate, then StyleEase can run without intervention; 
otherwise, Word needs to ask you about our safety each time it opens a document.

Different versions of Word use different methods to allow you to trust our certificate:
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Trusting Our Certificate in Word 2003 or Earlier 
Versions
Word displays a security warning when you first create a StyleEase document, as shown 
in Figure 2-1.

Figure 2-1: Trusting the StyleEase Certificate in Word 2003

Select the Always trust macros from this publisher box, and then click Enable Macros.

Trusting Our Certificate in Word 2007
You must enable our macros to use StyleEase. We recommend that you set Word 2007’s 
security settings to only enable macros that have been digitally signed, and to then trust 
our certificate. You need to follow these steps:

1. Change Word 2007’s Macro Setting to Disable all macros except digitally signed macros.

2. Create a new StyleEase document from the Windows Start Menu.

3. Trust the StyleEase Digital Certificate.

You only need to perform these steps one time on your computer; thereafter, Word will 
automatically allow any StyleEase documents to run without requiring extra steps.

Change Word 2007’s Macro Setting
1. Click the Office button in the top-left corner of a Word 2007 document window.

2. Click the Word Options button at the bottom of that screen.
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3. Click Trust Center and then click Trust Center Settings

4. Select the option to Disable all macros except digitally signed macros, as shown in Figure 
2-2.

Figure 2-2: Changing the macro settings in Word 2007

5. Click OK to save this change.

Trust the StyleEase Digital Certificate

When you first create a StyleEase document after you’ve changed the macro settings, 
Word will initially disable the macros and display both a message screen and a Security 
warning, which is shown in Figure 2-3.

Figure 2-3: The Word 2007 security warning

To allow StyleEase to run, follow these steps:

1. Close the message screen.

2. Click the Options button in the security warning. Word displays the security options 
screen shown in Figure 2-4.
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Figure 2-4: The Word 2007 security options screen

3. Select the Trust all document from this publisher and click OK. Thereafter all documents 
signed with our certificate will be trusted by Word 2007.

Creating StyleEase Documents
This section describes how to start a new StyleEase document. Before creating a new 
document, make sure that you have your macro security setting in Word set to allow 
digitally signed software to run, as described in Editing Title Pages tells you how to 
customize the title pages that StyleEase can use Enabling StyleEase.

To create a new StyleEase document:

a. Click the Windows Start button, then All Programs, and then click StyleEase.

b. Click Chicago Style Document. (If you’re using a version that has been customized 
for your institution, click the name of the custom version, e.g. SWBTS Style 
Document).
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c. Select options for your document in the StyleEase Document Setup screen, as shown 
in Figure 2-5.

Figure 2-5: The Document Setup screen

You should first choose which type of document you want to create, then select which 
pages to include, and finally, type in the title and running head you want to appear in 
your document. Note that this simply defines the initial layout of your document and 
can be changed at a later time.

You can read more about the different StyleEase document types in the Basic Document 
Types topic, and you can read more about the document setup options and fields in the 
Document Setup Options topic.

Click here to view an interactive demonstration of creating a StyleEase document.
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Basic Document Types
You can create StyleEase document in four variations, which are shown in Table 2-1. Each 
document type is preconfigured to include specific pages and characteristics, and each 
can be reconfigured.

Note that you can modify which pages are included by clicking checkboxes in The 
Document Setup screen. You can also add or delete pages while you’re editing your 
document, as described in the Adding Special Pages and Sections and Adding Special 
Lists topics.

Table 2-1: StyleEase basic document types

StyleEase document type Purpose Sections included by default

Paper To write a journal article or 
other paper.

• Title page (with title page running 
header)

• Body of paper
• Works Cited

Term Paper To write a term paper. • Title page
• Body of paper
• Works Cited

Thesis To write a master’s thesis. • Title page
• Table of contents
• Body of paper
• Works Cited

Dissertation To write a dissertation. • Title page
• Copyright page
• Abstract
• Table of contents
• Body of paper
• Works Cited
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Document Setup Options
The Document Setup screen contains options that allow you to define the type of paper 
you want to create, title information, and which pages you want initially included in the 
document. Table 2-5 describes these options.

Using the StyleEase Commands
You access the StyleEase software by clicking commands in the StyleEase menu (for Word 
2003 or earlier versions) or in the StyleEase ribbon tab (for Word 2007). These commands 
automate and simplify the writing of your documents.

The StyleEase Menu

The StyleEase menu, shown in Figure 2-6, appears on the right side of Word’s menu bar, 
and contains a number of commands and several submenus, which are indicated by a 
small right-arrow in the menu itself. To use a StyleEase command, simply click the menu 
choice, or click the right-arrow to reveal the submenu, and click a command in the 
submenu.

Table 2-2: Document setup options

Option Description

Document type Click one of these buttons to choose which document type you want to create: 
paper, term paper, thesis, or dissertation. The Basic Document Types topic 
provides descriptions of each type.

Note: You cannot change the type of a document after you create it.

Pages to include Select pages that you want included in your document.
StyleEase preconfigures which special pages and lists to include for each 
document type, and most users do not need to make any changes in the initial 
configuration. 

Note: You can add or delete special pages and lists whenever you want.

Citation type Select whether you want to use footnotes, endnotes, or parenthetical citations in 
your document. This is ususally dictated by the institution or publication for 
which you’re writing.

Title page title Allows you to enter the title that you want shown on the title page of your 
document. You can change this at any time.

Running head Allows you to enter the abbreviated “running head” title that you want shown 
in the upper right corner of each page. You can change this at any time.
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Figure 2-6: The StyleEase menu

For information about each command, see The StyleEase Commands.

The Word 2007 StyleEase Ribbon Tab

The StyleEase ribbon tab, shown in Figure 2-7, also presents a number of command and 
drop-down lists, which are organized into sections (groups) for easier access. To use a 
StyleEase command, simply click the item in the ribbon tab, or click the down-arrow to 
reveal the drop-down list and then click an item.

Figure 2-7: The StyleEase Ribbon Tab

For more information about each StyleEase command, see The StyleEase Commands.
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The StyleEase Commands
Table 2-3 summarizes the StyleEase commands. The Menu Command column displays the 
commands in the menu used for Word 2003 and earlier, and the Ribbon Tab columns 
show the location and name of the same commands in the Word 2007 ribbon tab.

Table 2-3: Accessing the StyleEase Commands

Early Word Version Word 2007 Ribbon Tab

Menu Command Section Command Description

Create Reference Entry References Create Displays the StyleEase Reference Entry menu.

Format Text Format APA Heading
Normal Text
Block Quote

Displays a list of the formatting styles that you 
can apply to the text in your paper with a 
single click.
For more information, see Text Formatting 
with StyleEase Styles.

Insert Element Insert Figure
Table
List
Captions

Displays commands for inserting elements 
such as figures, tables, and lists (e.g. tables of 
contents and figures).
For more information, see
• Inserting Figures
• Inserting Tables
• Adding Special Lists
• Adding Captions

Insert New Page Insert Special Page Displays a list of pages/sections that you can 
add to your document.
For more information, see Adding Special 
Pages and Sections.

Update Page Layout Page Layout Numbering
Headers

Displays the StyleEase Page Layout screen, in 
which you can modify the title, running 
headers, and page number style and placement 
in your documents.
For more information, see Changing Page 
Headers and Numbering.

Prepare for Printing Page Layout Print Prepare Displays the StyleEase Print Preparation screen, 
which you can use to update numbering, lists, 
and references in your document. 
For more information, see Updating Your 
Document for Printing.

Location of References References Location Allows you to change the location in which 
your references are inserted. You can use this, 
for example, if you need a Bibliography section 
in addition to a Works Cited section.
For more information, see Creating a Second 
References Section.
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Formatting Existing Documents
You can retrofit existing papers for use with StyleEase by creating a new StyleEase 
document and pasting the content of the existing document into the new document. 
Here’s how:

• Create a new StyleEase document and make sure that it includes all of the sections 
included in the paper you’re reformatting. For example, if your paper includes an 
abstract and two appendixes, tell StyleEase to create a new document that also 
includes those sections.

• Also open the existing paper in Word.

• For each section in the paper (e.g. the abstract, a chapter, or the main body):

• copy the content from the existing paper by selecting the content and pressing 
CTRL-C on your keyboard

• paste it into the corresponding section of your StyleEase paper by pressing CTRL-V 
on your keyboard

• Go through the new StyleEase document and apply styles as required to format your 
document, as described in Text Formatting with StyleEase Styles.

Reformatting and Reference Entries
When you reformat an existing document with StyleEase you are assured that your 
paragraphs and pages are properly formatted; however, the reformatting process cannot 
capture complete information about references that were in the old paper. Specifically, 
StyleEase cannot:

Delete Section Insert Delete Section Allows you to delete an entire section of your 
document with one click.

Help StyleEase Help Displays the StyleEase help system.

About StyleEase StyleEase About
Updates

Displays version and date information for your 
StyleEase software, and provides a link for 
checking for new updates.

Table 2-3: Accessing the StyleEase Commands (continued)

Early Word Version Word 2007 Ribbon Tab

Menu Command Section Command Description
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• verify that an old reference entry contains all the information it should

• verify that the information in an old reference entry is correctly formatted

If you apply the Reference Entry style to a reference from your old paper, StyleEase makes 
sure that the paragraph itself is correctly formatted, with proper indentation and 
spacing; however, it cannot reformat the content of that paragraph.

Editing Title Pages
Each of the four basic StyleEase document types (paper, term paper, thesis, and 
dissertation) has a title page associated with it. If your institution requires a title page 
format that differs from the default, you can alter the title pages that StyleEase uses. 

The page associated with each document type is stored in a specific Word file, so to 
change it, you edit that file with Word. Table 2-4 shows the file name for each title page.

The title page files are located in the TitlePages folder inside the folder where 
StyleEase was installed on your computer, which in almost all cases is: 
C:\Program Files\StyleEase\TitlePages.

After you locate the file you want to change:

• make a backup copy of it

• edit it with Word and make whatever changes you need to make

• save the file

Thereafter, StyleEase will use the new version of the title page.

Table 2-4: Title page file names

Document Type File Name

Term Paper ChiTermPaperTitle.doc

Paper ChiPaperTitle.doc

Thesis ChiThesisTitle.doc

Dissertation ChiDissertTitle.doc
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StyleEase for Chicago/Turabian Style
SECTION 3 • 
Entering Content

This section describes how to enter content — text, special pages and lists, figures, tables, 
chapters, and sections — into your StyleEase documents. Read the following topics to 
understand how to use StyleEase styles and commands to enter and modify information 
in your documents:

• Text Formatting with StyleEase Styles

• Adding Special Pages and Sections

• Adding Special Lists

• Inserting Figures

• Inserting Tables

• Adding Captions

• Useful Word Options and Tips

Text Formatting with StyleEase Styles
The basic formatting features of StyleEase work by applying styles to text that you enter. 
Each style contains formatting instructions that are consistent with the Chicago style 
guidelines. When you apply a style to a paragraph, its formatting changes to match 
those instructions, including its spacing, margins, and font appearance.

In many cases, StyleEase automatically applies the style that you want while you’re 
typing. In other cases, such as when you want to insert a header in your document, you 
apply a StyleEase style after clicking in the paragraph to make it the current paragraph.

To apply a style with Word 2003 and earlier versions of StyleEase, click Format Text in the 
StyleEase menu, and then click the style you want applied, as shown in Figure 3-1.
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Figure 3-1: The StyleEase Format Text menu

If you are using Word 2007, apply a style by clicking one of the buttons in the Format 
section of the StyleEase ribbon tab, as shown in Figure 3-2.

Figure 3-2: Accessing the styles in Word 2007

StyleEase instantly reformats the paragraph.

The StyleEase Text Styles topic describes each of the styles defined by StyleEase.

The StyleEase Text Styles
Table 3-1 summarizes the formatting that each StyleEase style applies to the current 
paragraph.

Table 3-1: The StyleEase text styles

Format Text Style Description

Normal (indented) Paragraph Indented first line, double-spaced, normal text paragraph. 
This is the default style, automatically started every time 
you press Enter, e.g. after creating a subheading.
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Note: StyleEase automatically capitalizes chapter headings. You must type the text 
exactly as you want it to appear for all other styles.

You can adjust the formatting performed by some StyleEase styles if your institution has 
customized its standard, as described in the Changing Style Definitions topic.

Non-indented (normal) Paragraph Non-indented normal paragraph. 
Use this style following block quotes, tables or figures if 
wanting to continue text mid-paragraph.

Chapter Heading This  text style creates a new chapter in a new section, with a 
preceding page break, and a double-space following. The 
heading text is automatically capitalized. 
To create a line break (that is, a 2-line chapter heading) press 
CTRL-Enter in the place in the actual text in the paper where 
you want the break. 

First Level Subheading Center-justified bold text, preceded by a triple-space, and 
followed by a double-space.
Enter text in headline capitalization style; for example, This 
is Headline Cap Style.

Second Level Subheading Center-justified, normal text., preceded by a triple-space, 
and followed by a double-space.
Enter text in headline capitalization style.

Third Level Subheading Left-justified, italicized, bold text, preceded by a triple-
space, and followed by a double-space.
Enter text in headline capitalization style.

Fourth Level Subheading Left-justified, normal text, preceded by a triple-space, and 
followed by a double-space. 
Enter text in sentence capitalization style; for example,  This 
is sentence cap style.

Block Quote Indented (.5 inch ), single-spaced paragraph. The first line of 
text is not indented relative to the rest of the paragraph. 
Use this style if the quote does not begin a paragraph, or if 
you do not want the first line indented.

Block Quote (1st line indented) Indented, single-spaced paragraph. The first line of text is 
indented 0.5 inch relative to the rest of the paragraph. 
Use this style if the quote begins a paragraph.

Table 3-1: The StyleEase text styles (continued)
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Adding Special Pages and Sections
When you create a new StyleEase document, you can specify that you want to include 
certain special sections, such as an abstract page, an appendix, or a table of contents, as 
described in the Creating StyleEase Documents topic. You can also add these sections 
(special pages or lists) while working on your documents or delete an unwanted section 
from a document.

IMPORTANT: Before adding a special page or section, make sure that you have 
positioned the insertion point in your document immediately before 
(above) where you want the new page or section inserted.

To add a special page in Word 2003 or earlier versions, click the Insert New Page 
submenu in the StyleEase menu, which is shown in Figure 3-3. Then select the type of 
page or section you want to add.

Figure 3-3: Inserting a new page

In Word 2007, click the Special Pages drop-down in the StyleEase ribbon tab, shown in 
Figure 3-4, and then select the type of page or section you want to insert.
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Figure 3-4: Inserting a New Special Page in Word 2007

If you add a new section, chapter, or appendix, StyleEase asks you for its title.

Note: StyleEase automatically updates any List of Illustrations, List of Tables, or 
Table of Contents in your document whenever you add or delete a section.

Deleting a special section

You can also delete sections from your document at any time by clicking somewhere in 
the section (to make it the current selection in Word) and then clicking the Delete Section 
command in the StyleEase menu or ribbon tab.

Adding Special Lists
You can add special lists — a Table of Contents, List of Illustrations (or List of Figures), or 
List of Tables — to your document, and StyleEase will automatically update them for you. 
In some versions, you can also add a List of Abbreviations to your document.

IMPORTANT: Before adding a special list, make sure that you have positioned the 
insertion point in your document immediately before (above) where 
you want it inserted.

To add a special page in Word 2003 or earlier versions, click the Insert New Page 
submenu in the StyleEase menu, which is shown in Figure 3-5. Then select the type of list 
that you want to insert in your document.
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Figure 3-5: Inserting a new special list

In Word 2007, click the List drop-down in the StyleEase ribbon tab, shown in Figure 3-6, 
and then select the type of list you want to insert.

Figure 3-6: Inserting a new special list in Word 2007

StyleEase automatically updates the new list when you add it.

Deleting a Special List

You can also delete special lists from your document at any time by clicking somewhere 
in the list (to make it the current selection in Word) and then clicking the Delete Section 
command in the StyleEase menu or ribbon tab.
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Inserting Figures
To insert a graphic image (figure) into your document, click the StyleEase Insert Element 
submenu and then select one of the Figure with caption commands: you can insert a figure 
from a file on your computer, or insert from the clipboard if you have previously copied 
an image onto the clipboard. In Word 2007, click the Figure dropdown in the StyleEase 
ribbon tab and then select either From File or From Clipboard.

Note: Before inserting a figure, make sure that you have positioned the insertion 
point in your document to above where you want it inserted.

If you’re inserting from a file, StyleEase will ask you to locate the file on your computer 
with Word’s Insert Picture screen, as shown in Figure 3-7.

Figure 3-7: The Insert Picture screen

After inserting the image, StyleEase displays a screen, shown in Figure 3-8, in which you 
enter the caption that you want in your document for the image. Note that StyleEase 
automatically corrects the spacing in your caption.
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Figure 3-8: The Figure Caption entry screen

You can alter the placement and size of the figure that you inserted by right-clicking on 
the image in your document, and clicking Format Picture.

If your document includes a List of Figures, StyleEase automatically updates that list with 
information about the new figure.

Inserting Tables
To insert a table into your document, click the StyleEase Insert Element submenu and then 
select the Table with caption command; in Word 2007, click the Table item in the StyleEase 
ribbon tab.

Note: Before inserting a figure, make sure that you have positioned the insertion 
point in your document to above where you want it inserted.

You then specify the table’s dimensions, as shown in Figure 3-9. You can alter the size of 
the table at any time, so you just need to define its initial dimensions. 
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Figure 3-9: The Insert Table screen

Note: StyleEase automatically creates a table in the default Chicago/Turabian format, 
which includes horizontal lines at the top of the table, below the first (heading) 
row, and at the bottom of the table.

After you have specified the table’s dimensions, click OK, and then enter a caption for 
your table, in the table caption screen shown in Figure 3-10. Note that StyleEase 
automatically corrects the spacing in your caption.

Figure 3-10: The Table Caption entry screen
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If your document includes a List of Tables, StyleEase automatically updates that list with 
information about the new table.

Adding Captions
If your document includes figures or tables that do not have captions, you can use 
StyleEase commands to add a caption in Chicago/Turabian style. Your captions are 
automatically added to any list of figures or list of tables you have.

Figure Captions

To insert a figure caption, first click in the figure, and then select the Figure caption 
command from the StyleEase Insert Element submenu; in Word 2007, select Figure from 
the Caption drop-down in the StyleEase ribbon tab. Then enter your caption text in the 
top line of the Table Caption screen shown in Figure 3-11 and click OK.

Note that you can only use this command if you have first clicked in a figure.

Figure 3-11: The Figure Caption entry screen

Note that StyleEase automatically corrects the spacing in your caption.

Table Captions

To insert a table caption, first click in the table, and then select the Table caption command 
from the StyleEase Insert Element submenu; in Word 2007, select Table from the Caption 
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drop-down in the StyleEase ribbon tab. Then enter your caption text in the top line of the 
Table Caption screen shown in Figure 3-12 and click OK.

Note that you can only use this command if you have first clicked in a table.

Figure 3-12: The Table Caption entry screen

Note that StyleEase automatically corrects the spacing in your caption.

If your document includes a List of Tables, StyleEase automatically updates that list with 
information about the new table.

Useful Word Options and Tips
This section presents a few options and tips that you might find useful when entering or 
selecting text in your Word documents.

Selection Tips

Word makes it easy to select text with the mouse. You can select:

• a word at a time by double-clicking on any word

• a line of text by moving the cursor to the left edge of the document window until it 
changes shape, and then clicking the mouse

• a paragraph by triple-clicking anywhere in the paragraph
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Typing Tips

If you need to create a new line in a document without making it a separate paragraph, 
you can press the Shift and Return keys (together) instead of just the Return key. Use this 
in situations like when the title of a chapter is too long to fit on a single line.

Displaying Formatting Marks for Easier Editing

Knowing where tabs, spaces, and paragraph marks are can sometimes make editing a 
document easer. 

In Word 2003, use the View Options screen to tell Word to display these marks in your 
document. Click Options in the Tools menu, then click View to display the View Options 
screen, and select the options you want.

In Word 2007, click on the Office button, choose Word Options (at the bottom of the 
screen), and then click on Display. Select options in the Formatting marks section, as 
shown in Figure 3-13.

Figure 3-13: Displaying formatting marks

Note that the formatting marks are not printed; they are displayed on-screen only.
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StyleEase for Chicago/Turabian Style
SECTION 4 • 
Citing References

One of the most difficult tasks you face in working with academic documents is citing 
references. StyleEase simplifies and automates this by providing a menu of reference 
types. After you select the type of reference you want to insert, StyleEase displays a 
reference entry screen in which you supply the information required to properly cite the 
reference. StyleEase then:

• correctly formats the reference

• inserts it into your Works Cited list

• adds a citation (an endnote, footnote, or parenthetical citation) to your document

This section contains the following topics to help you with citing references:

• Selecting the Reference Type explains using the References menu to select the type of 
source your are citing.

• Using Reference Entry Screens explains the features of StyleEase reference entry 
screens.

• Creating In-text Citations tells you how to customize the in-text citations added for 
each reference entry that you add.

Click here to view an interactive demonstration of creating reference entries.

Selecting the Reference Type
To create a new reference entry, select Create Reference Entry from the StyleEase menu, or 
click Create in the References section of the StyleEase ribbon tab. Then select a reference 
type from the References menu that StyleEase displays, which is shown in Figure 4-1.
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Figure 4-1: Selecting a reference type

Selecting a Type

You can select a type by clicking its name in one of the lists, or you can type an entry 
number in the number entry field. When you select an entry type, StyleEase displays a 
brief description of the type in the Entry type information field.
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Insert Multiple Entries at Once

If you want to create a number of reference entries in a row, without inserting citations, 
you can use StyleEase multiple-entry mode. You typically use this mode to add a number 
of bibliography entries at the end of your document.

Use this mode by selecting the multiple entry checkbox in the References menu. While in 
this mode, StyleEase automatically redisplays the References menu after you’ve inserted a 
reference entry. This continues until you click Cancel in the menu screen.

Using Reference Entry Screens
You fill in fields in a StyleEase reference entry screen (form) to specify the bibliographic 
data that you want StyleEase to enter. Each reference entry type has its own entry form 
that is configured specifically for that type. 

This section describes the reference entry data screens, which are form screens in which 
you enter the information that StyleEase uses to format and insert your reference entries 
and citations.

Each reference entry type has its own form screen, with its own set of text and option 
fields. However, you use all of the reference entry screens in the same way.

• Reference Entry Screen Components illustrates a typical reference entry screen.

• Navigating in Reference Entry Features describes shortcuts for moving through 
fields.

• Field Help and Sample Text describes two StyleEase features that help you with 
entering text into fields.

• Previewing Your Entry shows how new reference entries and citations are previewed 
in reference entry screens.

Reference Entry Screen Components
Figure 4-2 shows a typical reference entry screen and its components.
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Figure 4-2: StyleEase Reference Entry screen
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Navigating in Reference Entry Features
The basic action in a StyleEase reference entry form screen is to click in a text field and 
start typing in data for the field. You can also use the mouse and keyboard actions 
shown in Table 4-1 to navigate through and/or modify the fields in a form screen.

Field Help and Sample Text
You can hover your mouse over a text field in a reference entry form to display specific 
help for the field. StyleEase displays this data entry tip until you stop hovering the mouse 
(by moving it).

StyleEase also displays sample text in each entry field to show you what your input 
should look like. As soon as you start typing, the sample text disappears. If you’ve 
already entered text into the field and want to see what the sample text looked like, 
simply press the F2 key to display it above the field, as shown Figure 4-3. Then press F2 
again or move the insertion point to another field to turn off the sample text display.

Figure 4-3: Redisplaying the example text for a text field

Table 4-1: Navigating through reference entry fields 

Task Action

Enter text into a field.
Note that fields initialy display example text that is replaced as 
soon as you start typing.

Click a text field and start typing

Select (highlight) an entire text field you have entered. You can 
then press the Delete key or begin typing to delete the field text.

Triple-click

Move the focus to the next text field available for entry. The field 
will be highlighted.
You can leave example text showing in the field if you don’t want 
to enter any value for it.

Press the Tab key

Move the focus to the previous text field available for entry. Press Ctrl-Tab keys

Delete text. Press the Delete key

Copy text using the CTRL-C keys, and then paste it into a text 
field by pressing the CTRL-V keys.

Cut and paste in text fields
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Previewing Your Entry
StyleEase displays a preview of the reference entry and citation that you are creating in 
the small preview window at the bottom of the reference entry form screen. This 
preview is updated whenever you update information in the screen.

Figure 4-4: Reference entry preview

The preview is not editable; to change what will be inserted into your document, edit the 
values in the reference entry fields.

Note: StyleEase cannot display font attributes such as italics and underlining in the 
preview window, and uses <I>, <B>, <U> and </I>, </B>, </U> to bracket them. 
The entry in your document will contain actual italics, bold face, or underlining.

Alphabetizing (Sorting) References
To alphabetize your list of references, you need to use the StyleEase SmartSort feature, 
which applies all of Chicago/Turabian Style sorting rules to the references. In Word 
2007, you can click SmartSort in the StyleEase ribbon tab. 

And in any version of Word, you can click Prepare for Printing in the StyleEase menu or 
click Print Prepare in the ribbon tab to display the Print Preparation screen. Then select 
SmartSort your bibliography and click OK.

IMPORTANT: It’s a good idea to visually inspect the sorting of reference entries. 
There may be unique reference entries that do not get sorted in the 
correct order.

Rearranging the Order of Reference Entries

If your institution requires further refinement of the sorting, such as arranging 
consecutive entries by an author in chronological rather than alphabetical order, you can 
manually cut and paste entries.
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Be certain to cut the entire paragraph by triple-clicking your mouse in it and pressing 
CTRL-X. Then move the insertion point to where you want the reference inserted, and 
press CTRL-V.

Creating In-text Citations
StyleEase automatically creates citations in your documents whenever you create a 
reference entry. You can create citations in three formats:

• footnoted citations

• endnoted citations

• parenthetical reference citations

This section describes StyleEase citations in the following topics:

• Selecting Your Document’s Citation Type describes the different types of citations 
that you can use in StyleEase documents.

• Inserting and Editing Footnotes and Endnotes describes using note citations in your 
documents.

• Using Parenthetical References describes using parenthetical citations in your 
documents.

• Adding Content-only Notes describes how to add content-only notes, which are notes 
that are not related to a specific reference source.

Note: This guide uses the term note to refer to a footnote or endnote, and uses the 
term citation to refer to a footnote, endnote, or parenthetical reference.

Selecting Your Document’s Citation Type
You can only use one citation type in a document (you can’t mix endnotes and footnotes, 
or notes and parenthetical references), so StyleEase asks you to specify the citation type 
when you create the document, in the Document Setup screen, which is described in 
Document Setup Options.
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You can choose from among four citation types for each StyleEase document you create. 
Table 4-2 describes the four types.

Table 4-2: Citation types

Citation type Description

Footnotes When you insert your reference, StyleEase:
• adds an entry to your Works Cited list
• inserts a footnote at the bottom of the current page
• inserts a superscripted footnote number at the 

current location in your document

Endnotes When you insert your reference, StyleEase:
• adds an entry to your Works Cited list
• inserts an endnote in the Notes section at the end of 

your document
• inserts a superscripted endnote number at the 

current location in your document

Parenthetical - with footnoted 
comments

When you insert your reference, StyleEase:
• adds an entry to your Works Cited list
• inserts a parenthetical citation at the current location 

in your document
Whenever you insert a content-only note (see Adding 
Content-only Notes), StyleEase:

• inserts the comment footnote at the bottom of the 
current page

• inserts a superscripted footnote number at the 
current location in your document

Parenthetical - with endnoted 
comments

When you insert your reference, StyleEase:
• adds an entry to your Works Cited list
• inserts a parenthetical citation at the current location 

in your document
Whenever you insert a content-only note (see Adding 
Content-only Notes), StyleEase:

• inserts the comment endnote in the Notes section at 
the end of your document

• inserts a superscripted endnote number at the 
current location in your document
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Inserting and Editing Footnotes and Endnotes
If you have specified that you want to use footnotes or endnotes in a document, StyleEase 
inserts a note whenever you create a reference entry. You can unselect the Insert 
checkbox in the reference entry screen if you don’t want a note for an entry you create.

Figure 4-5: Selecting whether to insert a footnote or endnote

StyleEase uses the information you enter for the reference entry to format footnotes and 
endnotes in accordance with Chicago/Turabian style.

Adding Comments to Footnotes and Endnotes

You can insert comment text in front of any endnote or footnote that you add to your 
document by clicking Insert Reference with Comment button instead of the Insert Reference 
button in the reference entry screen.

StyleEase inserts the reference entry into your Works Cited section, and then displays the 
Insert Footnote/Endnote Comment screen, shown in Figure 4-6.

Figure 4-6: The Insert Footnote/Endnote Comment screen

StyleEase inserts whatever text you type in front of the new footnote (at the bottom of 
the page) or endnote (in the Notes section). In most cases, you should end your comment 
with a phrase such as as cited in.
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Creating Edited Copies of Notes

If you want to create an additional footnote or endnote for a source you’ve already cited, 
click Copy of endnote/footnote in the StyleEase Insert Element menu. StyleEase displays all of 
your notes, and allows you to pic the one you want to copy.

Figure 4-7: The note copying screen

After you select a note to copy, you can use the note editing screen to modify the copy:

Figure 4-8: The note editing screen

You typically need to modify the page numbers to which the note is referring, or shorten 
the note to Ibid.; for example, “Ibid., 3.” After you’ve made your changes, click Insert 
New Note to insert the edited note copy into the current location in your document.
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Using Shortened Versions of Notes Instead of Copying

Chicago/Turabian style allows you to shorten the content of a note (footnote or endnote) 
in the following circumstances:

• If the note refers to the same source as did the previous note, you can use Ibid. instead 
of repeating the source information. Typically, you create a footnote entry that looks 
something like the following: Ibid., 232.

• If the note refers to a source that you have used previously, but there are intervening 
notes in your document, then you can use a shortened version similar to the 
following: Lange, All Things Considered, 123. 

Viewing Footnotes

You can use one of the following methods to view the footnotes in your Word 
documents:

• If you are working in Normal view, click Footnotes in the View menu. Word displays 
the notes in your document in a split screen at the bottom of the window, as shown in 
Figure 4-9.

Figure 4-9: Displaying footnotes in Normal view

• If you are using Print Layout (or Page Layout) view, your footnotes appear at the 
bottom of the page, separated from the body of your paper, as shown in Figure 4-10.
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Figure 4-10: Viewing footnotes in Print Layout view

Note that endnotes are displayed on the Notes page at the end of your document.

Note: Because the bibliography entries in your Works Cited section are created 
separately from the corresponding note, Word cannot automatically delete or 
change the reference entry when you delete or change the note. You must 
remember to make the change in both locations.

Deleting Notes

You can delete a note (a footnote or an endnote) from your document by following these 
steps:

1. Select (highlight) the note number that you want to delete. This is the superscripted 
(small, raised) number that represents the note in the body of your document.

2. Click Clear in the Edit menu to delete the note from your document.

Note: Word automatically renumbers all of the notes in the document after you 
deleted one.

Fixing Endnote Numbering

When you use StyleEase with Microsoft Word to create endnotes in a document, each 
endnote is created with Word’s endnote number format, which uses superscripted 
numbers. The Chicago/Turabian standard calls for endnotes numbers to use normal 
(non-superscripted) numbers instead.

StyleEase handles corrects this numbering problem for you: simply click the Fix endnote 
numbering option in the Print Prepare screen, which is described in Updating Your 
Document for Printing.
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Using Parenthetical References
When you choose parenthetical references as the citation type for your document, 
StyleEase inserts (optionally) a parenthetical reference at the current location in your 
document whenever you insert a reference entry into your Works Cited section.

Note: You can tell StyleEase to not insert a citation by unchecking the Insert Citation 
checkbox in the reference entry screen, as shown in Figure 4-11.

Parenthetical references have the general form (Author Year). For example, (Hillerson 
1999). If you check the Insert Pages checkbox (shown in Figure 4-11), StyleEase will also 
include in the citation the page number(s) that you specify in the reference.

Figure 4-11: Parenthetical reference options

StyleEase displays a preview of the parenthetical reference at the bottom of the reference 
entry screen. This preview is updated whenever you modify a field in the reference 
entry form. Figure 4-12 shows an example of the citation (and reference entry) preview 
windows.

Figure 4-12: Previewing a parenthetical reference

Note that you can add content-only notes in either footnote or endnote format when 
using parenthetical citations. See “Adding Content-only Notes” on page 36 for more 
information.

Adding Content-only Notes
You can use StyleEase to add content-only (pure text that does not relate to a specific 
reference source) footnotes or endnotes. These notes are typically used to provide 
commentary about a subject.

Note: You can also include content-only notes in documents that use parenthetical 
citations.
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To add a content-only note, click content-only footnote/endnote in the StyleEase Insert 
Element menu or in the End/Footnote drop down in the ribbon, and enter your text in the 
Comment Note Entry screen.

Figure 4-13: The Comment Note Entry screen

StyleEase inserts a footnote at the bottom of the current page, or an endnote in the Notes 
section, depending on what citation type you specified when you created the document. 
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StyleEase for Chicago/Turabian Style
SECTION 5 • 
Fine-tuning Document 
Appearance

This section contains topics that address fine-tuning the appearance of your StyleEase 
document:

• Changing Page Headers and Numbering tells you how to modify the layout of your 
pages.

• Updating Your Document for Printing describes how to use the Print Preparation 
feature of StyleEase to make sure that your document is ready for final printing.

• Changing Style Definitions tells you how to change style definitions to alter the 
appearance of paragraphs in your document.

• Editing StyleEase Title Pages tells you how to create alternative title pages for your 
StyleEase documents.

• Creating a Second References Section explains how to add a second bibliography 
section to your document, which is required by some institutions.

Changing Page Headers and Numbering
The page layout of your document — its working title, how the pages are numbered, 
and the running header that appears on each page — is set up for you by StyleEase when 
you create a new document. You can customize the appearance of your document by 
modifying these layout characteristics.

To change the layout of your pages, click Update Page Layout in the StyleEase menu, or 
click either Numbering or Headers in the Page Layout section of the StyleEase ribbon tab. 
Then set options and values in the Page Headers and Numbering screen that’s shown in 
Figure 5-1.
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The screen allows you to specify three different forms for your document’s title:

• The Paper Title is the full title of your document, as displayed on the title page.

• The Running head is the abbreviated title shown at the top of each page. 

Figure 5-1: Modifying page headers and numbering

The StyleEase Page Headers and Numbering screen also allows you to specify separate page 
numbering rules for different sections of your document. The default settings match the 
typical settings for Chicago/Turabian style documents, but some institutions have their 
own page numbering standards. 

Each section’s page numbers can be set to:

• not display

• display in the upper right corner of the page

• display in the bottom center of the page
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Some of the sections have additional page numbering options, as described in Table 5-1.

IMPORTANT: You must use the StyleEase Page Headers and Numbering screen to 
make all changes in titles, running headers, and page numbering. If 
you manually make changes directly in your document, StyleEase and 
Word will not correctly update your numbering and special lists.

Updating Your Document for Printing
When you’re ready to print your document, it’s a good idea to use the StyleEase print 
preparation feature to make sure that your references are correctly sorted (alphabetized) 
and that all of your special lists have the correct page numbering. 

Click Prepare for Printing in the StyleEase menu or click Print Prepare on the StyleEase 
ribbon tab to display the Print Preparation screen, which is shown in Figure 5-2. Select the 
updates that you want to perform before printing, and then click OK.

Table 5-1: Page numbering options for different parts of a paper

Page(s) Description Additional Options

Title page The title page of your document. The page number can be displayed using 
Roman or Arabic numerals. 
This page can optionally include a 
running header.

Front matter The set of pages that follow the title 
page and precede the first page of the 
body of the document.

The page number can be displayed using 
Roman or Arabic numerals. 
This page can optionally include a 
running header.

Front page of each 
section

The first page of a chapter or 
appendix in a multichapter 
document.

If Restart numbering at 1 is selected, 
StyleEase sets the page number of the 
first page of the first chapter to 1. If this 
option is not selected, the number of the 
first page of the first chapter continues 
the previous numbering.

Body pages The body of your document.
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Figure 5-2: Preparing for printing

Table 5-2 describes the print preparation options.

Note: If you manually modify a list like the List of Illustrations in your 
document, you might not want it automatically updated, so you would 
deselect this option. 

Table 5-2: StyleEase print preparation options

Option Description

Modify page layout, document title, 
and/or running heads

Select this to have StyleEase open up the Page Headers and 
Numbering screen before printing. See Changing Page Headers 
and Numbering for more information.

SmartSort your bibliography Automatically alphabetizes your References section using 
sorting rules specified for Chicago/Turabian style. See the 
Alphabetizing (Sorting) References topic for more information.

Fix endnote numbering If your document uses endnotes, this fixes Word’s default 
endnote numbering style to the style required for Chicago/
Turabian style.

Update table of contents Automatically updates the Table of Contents for your paper.

Update list of illustrations Automatically updates the List of Illustrations (or List of Figures) 
for your paper, if you have chosen to include one. 

Update list of tables Automatically updates the List of Tables for your paper, if you 
have chosen to include one. 
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After you click OK to prepare your document for printing, StyleEase updates the 
document and displays a report about the updates.

Changing Style Definitions
If your institution uses non-standard formatting for certain types of paragraphs, you can 
change the paragraph style definition. For example, some schools require block quotes 
or reference entries to use single spacing, rather than the standard double-spacing. 

This section shows you how to make style definition changes, using the following 
examples:

• Making Block Quotes Single-Spaced

• Making References Single-Spaced

• Changing the Document Font

Making Block Quotes Single-Spaced
Some institutions specify that block quotes are single-spaced rather than double-spaced. 
To make this change in your paper, you need to change two style definitions: Block Quote 
and Block Quote (1st line indented), setting the line spacing of each to single-spaced. Make 
the change as follows:

• Select the style you want to change in the Styles pane, and tell Word to modify the 
style

In Word 2003 and earlier, click Styles and Formatting in Word’s Format menu to display 
the Styles pane, shown in Figure 5-3. Then right-click Block Quote and click Modify.
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Figure 5-3: The Word 2003 Styles and Formatting Pane

In Word 2007, find the Styles section on the Home tab of the Ribbon, and click the 
dialog arrow in the lower-right corner of that section to display the Styles pane, as 
shown in Figure 5-4. Then click Block Quote, click the down arrow that appears on its 
right side, and click Modify.

Figure 5-4: The Word 2007 Styles Pane

In Word’s Modify Style screen, click the Format down-arrow and select Paragraph to 
modify the paragraph formatting of the Block Quote style.
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Figure 5-5: Modifying the Block Quote style definition

In the Modify Paragraph style screen that displays, change the Line spacing field from 
Double (or 28 pt) to Single and then click OK.
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Figure 5-6: Modifying the Block Quote paragraph style

Making References Single-Spaced
Some schools make reference entries single-spaced, rather than the standard double-
spacing. You can apply the directions in the Making Block Quotes Single-Spaced topic to 
the style named Reference Entry.

Changing the Document Font
StyleEase uses Times New Roman as the default font for all styles in documents. You can 
change the font used for your document by altering the definition of the style named 
Normal. 

Click Normal in Word’s Styles pane (as described in Making Block Quotes Single-Spaced) 
and select Modify. Then, click Format at the bottom of the Modify Style screen and choose 
Font to display the Font formatting for the Normal style, as shown in Figure 5-7.

Select a new font, then click OK several times to close the style modification screens. 
Your entire document will switch to using the font that you just chose.
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Figure 5-7: The Modify Font screen

Editing StyleEase Title Pages
Each of the four basic StyleEase document types (paper, term paper, thesis, and 
dissertation) has a title page associated with it. If your institution requires a title page 
format that differs from the default, you can alter the title pages that StyleEase uses. 
These pages are stored in the folder where the StyleEase program and data files reside 
on your computer. This is C:\Program Files\StyleEase in almost all cases.

Open an Explorer window on your desktop and navigate to 
C:\Program Files\StyleEase\TitlePages. Then edit the title page you want to 
change, and save it. For example, if you you’re going to edit the title page used for 
Chicago/Turabian-style term papers, edit the ChiTermPaperTitle.doc file.

Thereafter, whenever you create a new StyleEase document (e.g. an Chicago/Turabian-
style term paper), your new document will include the new version of your title page.
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Creating a Second References Section
Some institutions use two reference sections, adding a separate bibliography page at the 
end of the document, in addition to the standard reference list. To create a new reference 
section:

• Insert a new section into your document, as described in Adding Special Pages and 
Sections. When asked, tell StyleEase to use the title Bibliography for the new section.

• Move the insertion point to just after the “y” in Bibliography.

• Click the Location of References command in the StyleEase menu, or click Location in the 
References section of the StyleEase ribbon tab.

StyleEase subsequently adds any new reference entries to the new section.

To return to adding references to the standard reference list section, click after the "d" in 
Works Cited, and once again click the location command in the StyleEase menu or 
ribbon tab.
StyleEase User’s Guide 47



StyleEase for Chicago/Turabian Style
Index

A
About StyleEase 1
adding comments 32
adding special pages 15
alphabetizing 29
applying styles 12

B
basic document types 6
bibliography 47
Block Quote 14
Block Quote (1st line indented) 14

C
captions 20, 21, 22
changing

numbering 40
page headers 40
titles 40

changing fonts 45
changing style definitions 42
Chapter Heading 14
Chicago style paper 6
Chicago-style Dissertation 6
Chicago-style Term Paper 6
Chicago-style Thesis 6
citation type

selecting 30
citation types

parenthetical references 36
citations

creating 30
endnoted 30
footnoted 30
parenthetical reference 30

commands, accessing 7, 8
commands, StyleEase 9
comments

in footnotes and endnotes 32

content-only notes 36
copying notes 33
creating a new Document 4
creating citations 30
creating new documents 4
creating references

from the database 38
Cut and paste 28

D
database

about 38
using 38

document setup 7
documents

adding special pages 15
basic types 6
changing font used 45
creating 4
formatting existing 10
inserting figures 18
inserting tables 19
printing 40
setting up new 7

E
editing title pages 11, 46
endnoted citations 30
endnotes 31

adding comments to 32
content-only 36
copying 33
deleting 35
fixing numbering of 35
inserting 32
short versions of 34

entering reference entry information 26
existing documents

formatting 10
StyleEase User’s Guide 48



F
figures

caption 21
inserting 18

First Level Subheading 14
fixing endnote numbering 35
font

changing 45
footnoted citations 30
footnotes 31

adding comments to 32
content-only 36
copying 33
deleting 35
inserting 32
short versions of 34
viewing 34

formatting
of existing documents 10

Fourth Level Subheading 14

I
Ibid 34
inserting

footnotes and endnotes 32
inserting figures 18
inserting tables 19

L
list of tables

updating 41

M
men 7

N
new documents, creating 4
Non-indented (normal) Paragraph 14
Normal (indented) Paragraph 13
notes

copying 33
deleting 35
short versions of 34

numbering pages 40

P
page layout

updating 41
page numbering 40
pages

adding to your documents 15
parenthetical reference citations 30
parenthetical references 36

previewing 36
prepare for printing 40
printing documents 40

Q
quotations

changing to single-spaced 42

R
rearranging reference entries 29
reference entries

entering information in 26
reference entry screens 27
reference list 47
references

creating a 2nd list 47
rearranging 29
single spacing 45
sorting 29

ribbon tab 8

S
screens

reference entry 27
Second Level Subheading 14
selecting text

line-by-line 22
word-by-word 22

short versions 34
single spacing 45
single-spacing 42
SmartSort 29
sorting reference entries 29

SmartSort 41
StyleEase

about 1
adding special pages 15
StyleEase User’s Guide 49



basic document types 6
changing style definitions 42
creating citations 30
creating documents 4
document setup 7
entering reference entry data 26
inserting figures 18
inserting tables 19
prepare for printing 40
printing 40
SmartSort 29, 41
text styles 13
use with existing documents 10
using 1, 12, 24

StyleEase commands 9
StyleEase documents 4
StyleEase menu 7
StyleEase ribbon tab 8
styles 13

Block Quote 14
Block Quote (1st line indented) 14
changing definitions of 42
Chapter Heading 14
First Level Subheading 14
Fourth Level Subheading 14
Non-indented (normal) Paragraph 14
Normal (indented) Paragraph 13
Second Level Subheading 14
Third Level Subheading 14

styles, applying 12

T
table of contents

updating 41
tables

captions 20, 22
inserting 19

text fields
pasting into 28

text styles 13
Third Level Subheading 14
title pages

editing 11, 46

U
updating list of tables 41
updating page layout 41
updating table of contents 41

using StyleEase 1, 12, 24

V
viewing footnotes 34
StyleEase User’s Guide 50


	SECTION 1 • Getting Started
	Enabling StyleEase
	Trusting Our Certificate in Word 2003 or Earlier Versions
	Trusting Our Certificate in Word 2007
	Change Word 2007’s Macro Setting
	Trust the StyleEase Digital Certificate


	Creating a New Document
	Using StyleEase Commands
	Entering Document Content
	Citing References
	Changing Page Headers and Numbering
	Preparing and Printing Documents

	SECTION 2 • Using StyleEase
	Editing Title Pages tells you how to customize the title pages that StyleEase can use Enabling St...
	Trusting Our Certificate in Word 2003 or Earlier Versions
	Trusting Our Certificate in Word 2007
	Change Word 2007’s Macro Setting
	Trust the StyleEase Digital Certificate


	Creating StyleEase Documents
	Basic Document Types
	Document Setup Options

	Using the StyleEase Commands
	The StyleEase Commands

	Formatting Existing Documents
	Reformatting and Reference Entries

	Editing Title Pages

	SECTION 3 • Entering Content
	Text Formatting with StyleEase Styles
	The StyleEase Text Styles

	Adding Special Pages and Sections
	Adding Special Lists
	Inserting Figures
	Inserting Tables
	Adding Captions
	Useful Word Options and Tips

	SECTION 4 • Citing References
	Selecting the Reference Type
	Using Reference Entry Screens
	Reference Entry Screen Components
	Navigating in Reference Entry Features
	Field Help and Sample Text
	Previewing Your Entry

	Alphabetizing (Sorting) References
	Creating In-text Citations
	Selecting Your Document’s Citation Type
	Inserting and Editing Footnotes and Endnotes
	Using Parenthetical References
	Adding Content-only Notes


	SECTION 5 • Fine-tuning Document Appearance
	Changing Page Headers and Numbering
	Updating Your Document for Printing
	Changing Style Definitions
	Making Block Quotes Single-Spaced
	Making References Single-Spaced
	Changing the Document Font

	Editing StyleEase Title Pages
	Creating a Second References Section

	Index
	A
	B
	C
	D
	E
	F
	I
	L
	M
	N
	P
	Q
	R
	S
	T
	U
	V


